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Getting Started

Access to Sorting

Your user profile level controls what you can do in terms of sorting levels, attribute relationships, measure items,

and totals in views.

User Profile Level Apply New Sorts Edit Existing Sorts
Casual ® o
Advanced W o
View Administrator Y 4 4
Security Administrator .,f .,f

*Note: Casual users can click an existing sort icon to change a sort. They will not see a Sort option when they right-
click in the grid to access the grid pop-up menu.
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Introduction to Sorting

Sorts are a means of sequencing your data in a way that is most meaningful to you. Descending and ascending
sorts can be applied to a level, an attribute relationship for a level, a measure item, or totals. You can combine sorts
with filters to achieve a view of data that best fits your particular business needs.

Alphanumeric Sorts

Stratum.Viewer will sort non-calendar based objects alphanumerically. This view has an ascending sort on the first
measure item.

E:Z+ View Hame: Safes by Type and Territory
4|~ View Filter
[ & Actual Sales Actu?l Sal_es Ext Difference Actu?l Sal_es Ext Actu?l Sal_es E
Customer Ship-To Territory Ext List Price List Price Current Wk List Price Pt fas
Type Wk382014t0 | Wk382013to UIETCTRC wk372014t0  Wk372013tg
Wk 38 2014 Wk 38 2013 Wk372014  Wk37 2013
Class A Customer Central Provinces 51,251 445 81.407,532 -5156,087 £1,539.277 51,407 53
Gulf Coast $1,356,559 $2,107.039  $750.480 $1,668,568 $2,107,03
Morthwest $1,686,239 $1,391,828 $294.411 $2,074,074 $1,391,8]
Great Plains 84 544 327 £4 838341 -$204 014 85,589,522 &4, 83834
Western Provinces %4.832,958 55,513,788 -5680,830 55,044 538 85,513,7¢
Midlantic $5,103,940 $5629220  -§525.280 $6,277,847 $5,629,2]
Eastern Atlantic Provinc 56,627,886 %7.647.500 -51,018,614 48,152,259 7,647 50
South Central 810,714,654 812,376,633 -51,661,979 £13,179.024 812,376,637
New England $15779,75%  -§2.297.828  $16382775  $15,778.7:

| sseooren]| sroo1ma]  serooron|  ssesone
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The next view has a descending sort on the Region level in columns and ascending sort on the UPC Long
Description attribute relationship in rows.

4| view Filter

UPC Global

0 - 24000 - 12431 -4
0-24000 - 12551 -4
0-02749 - 25408 - 6
0 - 02749 - 99267 - &
0 - 13800 - 30321 -9
0 - 13800 - 78934 -9
0 - 06403 - 92736 -2
0 - 24000 - 12520 -4
0-24000 - 12491 -4
0 - 24000 - 12591 -4
0 -24000 - 13578 -4
0 - 24000 - 13517 -4
0 - 70606 - 02252 -8
0-79453 - 50433 -6
0-79453 - 09722 -7
All Others

EIZ+ View Name: TotfalNumber Products Sold

¥ T Region >> 331 330
Rgn Long Description West East

f \ Sales Amount Sales Return  Number  Total T sales Sales Return  Number  Total

A UPCLong Q3 2014 to Amount of Mumber Amount Amount aof Number
Description 03 2014 Q32014to  Products of Q32014toQ3 Q32014te  Products of

03 2014 Sold  Products 2014 Q3 2014 Sold  Products
Applesauce 1060z PL* $12.208.965  ($254.621) 50 103 $43,709,710 (5394.621) o4 103
Applesauce 120z PL* 50 103 $30,325482 ($213,278) o4 103
Asparagus §11,748,521  ($372,973) 50 103 $32,856,000 ($1,057,052) o4 103
Cherries, Bing §14.001.060 ($529,751) 50 103 £32,473,135 ($1.202,761) G4 103
Frozen Lasagna Dinner 516,862,271 50 103 $59,440,138 94 103
Meatloaf, Frozen §15,994 439 50 103 $57.645.091 94 103
Orange Juice Conc. $9,566,166 50 105 $31,563.473 94 103
Peach 6oz LnchPk BR* 50 103 $20. 837455 ($252,701) o4 103
Peach Slcs LS 1060z BR* $2,320479  ($108,534) 50 103 $28.007,355 (§304,192) o4 103
Peach Slcs LS 120z BR* 50 103 $38.969,187 (3176.420) o4 103
Pear 6oz LnchPk LS 50 103 §25,837.466 (8171,811) a4 103
Pnappl Slcs 12 oz BR* 50 103 £27,126,524 (8318,541) a4 103
Pork Chops - Butterfly §8,406,051 30 103 $34,580,280 e4 103
Romaine Spedalty Salad §5,762,298 30 103 $26,027.675 94 103
Sweet Onions, Chopped §6.965,593 50 103 $26,900,805 94 103
$118.055,909 (%5,168.630) 50 103 $700,171.922 ($12.648224) 94 103

2

AlC

Q3
to
2

Grand Total $222,081,751 | ($6,434.517) 50 103 $1.225.521,698 | ($16,739,600) 103
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Calendar Based Sorts

Stratum.Viewer will sort calendar based objects according to their calendar order. Calendar based objects are
objects related to time, such as a Year or Months time level. In this view, descending sorts exist on the Year Based
level in columns and Months level in rows.

£33+ View Name: Monthly Sales Views

42 view ﬁterm

G T YearBased == CurrentYear Last Year )

/’- ¥ Months \ Mﬂﬁt Sales Units Awg Seling Price mﬂﬁt Sales Units  Awg Selling Price
December §220,048.674 3624739 $60.71
Movember $367,487,985 6,093,229 $60.31
October 354333571 6581500 §58.91
September $569,861,272 12,093,515 $47.12  $627,060,751 11,125,528 $56.36
August 8485764510 12,744274 §38.12  §755,754.97% 13414447 §56.34
July $381,877.666 5,613,083 $40.78  $997.610460 17,933,690 $55.63
June §375671,285 8,810,184 §42.16 5682857762 12242875 §55.78
May $352,020,685 7,798,302 §45.14 $468.934,747 8413481 $55.74
April §327.807.806 6,867,712 §4773 5645861506 11733747 §55.04
March $361,004,874 6,553,215 $55.09 $652,242,257 11,862,018 $54.59
February $322,332,391 5,825,361 §55.33  $549211.665 9929320 §55.31
anua $350,714,364 6,258,847 $36.03  $650,655,727 11,579,068 $56.19

e e e e e

Apply a New Sort

1. Right-click the object in the grid and select Sort then either Ascending or Descending. If you want to sort a
Grand Total, right-click the caption of the measure item in the Grand Total row or column.

OR
1. Double-click the object in view explorer to open its Properties window.

2. Select Ascending or Descending from the Sort drop-down list.

Note: Use the first option if you are sorting a measure item and there are levels on the same axis as measure
items. Also use the first option if you are sorting a Grand Total measure item.

Edit Existing Sorts

1. Click the sort icon (& or¥) next to the sorted object.

OR
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1. Double-click the object in view explorer to open its Properties window.

2. Change to Ascending or Descending using the Sort drop-down list.

Clear Sorts

Clear Individual Sort

Right-click the sorted object in the grid and select Sort then Clear.

OR

Double-click the object in view explorer to open its Properties window. Then select None from the Sort drop-down
list.

Clear All Sorts

Right-click any sorted object in the grid (measure item, level value, level attribute relationship), and select Sort then
Clear All.

Grid Pop-up Menus

Right-click objects in views to display available functionality for them such as inserting measure items, transposing
the grid, filtering objects in the grid, and so forth. Many of the functions can also be controlled through view explorer
and the Properties window, giving you several ways to make changes. Options on pop-up menus vary by user.
Your user profile level determines which options are available to you. The menus in these examples are for a user
with an advanced level of access. Menus are displayed in alphabetical order.

Attribute Relationships Pop-up Menu

Right-click an attribute relationship to display actions that you can take related to that object or axis.

Copy
Paste

Select All

Add
Edit b

Hide 9
Sort 3
Actions »
Transpose

View Explorer
Properties

®©@ 0 060

o Copy - This option allows you to copy sections of a view that you have selected.
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Paste - Allows you to paste data into update enabled cells. This option only shows in planning
enabled views.

Select All - Use this option to select the entire grid.

Add - The sub menu has options for adding Attribute Relationships, Regular Measure ltems,
Calculated Measure Items, and Charts. Windows for adding the selected type of item will display once
you make your selection from this sub menu.

m Attribute Relationships

Regular Measure Item
Calculated Measure Ttem

Chart

Edit - Edit the attribute relationships or edit hierarchies on the rows, columns, or view filter.

m Attribute Relationships

Rows

Columns

View Filter

Hide - When an attribute relationship is right-clicked and Hide is selected, the selected object is
hidden from the grid. The Visible property for the attribute relationship changes to No. From view
explorer, you can drag an attribute relationship back in the grid if needed, or you can change the
Visible property to Yes.

Sort - Sort options are Ascending, Descending, Remove, and Remove All.

Sort H Ascending
Descending
Remowve

Remove All

Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.

1
Actions 3 Add Action
Add View To Existing Action
Display Actions That Indude This View

Transpose - Use this option to change the axis for levels and measure items in the grid. Objects
displayed in columns are switched to display in rows and vice versa.

View Explorer - This option allows you to open and close view explorer. If the Properties window is
open when you close view explorer, the Properties window will also close.

Properties - Click to maintain the attribute relationship properties including sorting and whether it is
visible or not.
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Axis Pop-up Menu

Right-click the Rows or Columns headings in the Navigation Panel (or their filter icon if an axis is filtered) to display
a menu with options to edit properties of that axis including its filter, totals, or All Others properties. A shortcut to

adding hierarchies to the Rows or Columns of a view is to click the Add icon -+ in those sections of the Navigation
Panel.

Edit
Edit
Clear
Totals 4
All Others L4 Clear all
Froperties

General Pop-up Menu

Right-click within the grid to display actions that you can take such as transposing the rows, columns, and measure
items.

Copy
Paste

Select All

Add 4
Edit 4

Actions 4
Transpose

View Explorer

Copy - This option allows you to copy sections of a view that you have selected.

Paste - Allows you to paste data into update enabled cells. This option only shows in planning
enabled views.

Select All - Use this option to select the entire grid.

Add - The sub menu has options for adding Regular Measure Items, Calculated Measure Items, and
Charts. Windows for adding the selected type of item will display once you make your selection from
this sub menu.

© 0000

BT Regular Measure Ttem

Calculated Measure Item

Chart

Edit - Edit the hierarchies on the rows, columns, or view filter.

BT cos

Columns

View Filter

Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.
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Actions » Add Action
Add View To Existing Action
Display Actions That Indude This View

Transpose - Use this option to change the axis for levels and measure items in the grid. Objects
displayed in rows are switched to display in columns and vice versa.

View Explorer - This option allows you to open and close view explorer. If the Properties window is
open when you close view explorer, the Properties window will also close.

Measure Item Pop-up Menus (Detail and Grand Total Menus)

Measure items can be assigned to one axis, either rows or columns. Right-click the caption of a measure item in a
detail row or column to display actions that you can take related to that object, such as inserting additional measure
items or applying conditional formats.

Copy
Select All Occurrences

Select all

Add »
Edit
Delete

Hide
Sort b
Filter 3
Conditional Format 4
Actions 6
Transpose
6 View Explorer

Properties

Or, right-click the caption of a measure item in a Grand Total row or column to work with values in that area of a
view, such as by applying sorts and filters to them.

o0 O

Descriptions follow of the menus for measure items in detail and Grand Total rows or columns.

o Copy - This option allows you to copy sections of a view that you have selected.

Paste - Allows you to paste data into update enabled cells. This option only shows in planning
enabled views. This option does not display on the menu for Grand Totals.

Select All Occurrences - Use this option to select data for all occurrences of that measure item in
the active page of the View. This option does not display on the menu for Grand Totals.

Select All - Use this option to select the entire grid.

Add - The sub menu has options for adding Regular Measure Items, Calculated Measure Items, and
Charts. Windows for adding the selected type of item will display once you make your selection from
this sub menu.
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BT Regular Measure Ttem

Calculated Measure Item

Chart

Edit - For regular measure items, opens the Edit Measure Item window with that measure item
selected for editing. You can edit that measure item or any other regular measure items. For
calculated measure items, opens an Edit window where you can edit the calculation, caption, and
format for the calculated measure item.

Note: You also can access editing windows for measure items from the Measure Items window,
which is accessible from view toolbars, or by double-clicking the caption of the respective measure
item in the view grid.

Delete - Deletes the measure item from the view definition without confirmation. It will no longer
display in the view explorer.

Hide - When a measure item is right-clicked and Hide is selected, the selected object is hidden from
the grid. The Visible property for the measure item changes to No. From view explorer, you can drag
a measure item back in the grid if needed, or you can change the Visible property to Yes.

Sort - Sort options are Ascending, Descending, Clear, and Clear All.

|
T fscending

Descending
Clear

Clear Al

Filter - Filter options are Edit, Clear, and Clear All.

Edit

Clear

Clear Al I
L —

Conditional Format — Use this option to edit or add conditional formatting on the measure item.
There are also options for clearing the conditional format on the active measure item or all measure
items.

[ Conditional Format v
Actions r Clear
Transpose

Clear Al

Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.
1
Actions » Add Action
Add View To Existing Action
Display Actions That Indude This View

Transpose - Use this option to change the axis for levels and measure items in the grid. Objects
displayed in columns are switched to display in rows and vice versa.

5,

View Explorer - This option allows you to open and close view explorer. If the Properties window is
open when you close view explorer, the Properties window will also close.

Copyright 2020 Silvon Software, Inc. A/l rights reserved. (Last Revised. December 2020)




Properties - Click to maintain the measure item properties including the name, caption expression,
type, pop-up labels, hyperlinks, and so forth.

View Filter Pop-up Menu

Right-click the View Filter heading to display actions that you can take related to that object or section of the grid,
such as filtering levels in that section.

Q-

Properties

Edit - Edit the hierarchies in the view filter. A shortcut to adding hierarchies to the View Filter is to
click the Add icon ¥ that’s provided in the View Filter section of the view.

Levels Pop-up Menu

Right-click the level to display actions that you can take related to the level, such as editing the hierarchy.

Copy
o Paste
Select All
Add r
Edit r
Hide B
Sort »
Filter »
Actions k
Transpose
6 View Explorer
Properties
0 Copy - This option allows you to copy sections of a view that you have selected.
Paste - Allows you to paste data into update enabled cells. This option only shows in planning
enabled views.
Select All - Use this option to select the entire grid.
Add - The sub menu has options for adding Attribute Relationships, Regular Measure ltems,
Calculated Measure Items, and Charts. Windows for adding the selected type of item will display once

you make your selection from this sub menu.

m Attribute Relationships

Regular Measure Item
Calculated Measure Ttem

Chart

Edit - Edit the attribute relationships or edit hierarchies on the rows, columns, or view filter.
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m Attribute Relationships

Rows
Columns
View Filter

Hide - When a level is right-clicked and Hide is selected, the selected object is hidden from the grid.
The Visible property for the level changes to No. From view explorer, you can drag a level back in the
grid if needed, or you can change the Visible property to Yes.

Sort - Sort options are Ascending, Descending, Clear, and Clear All.

|
—_—
Descending
Clear

Clear Al

Filter - Filter options are Edit, Change Filter Type, Clear, and Clear All. Change Filter Type opens a
window where you can select the type of filter to set up or change. By default, a new filter you create
from the Filter > Edit option is a list of members from the level with which you are working.

Filter b Edit

Change Filter Type
Clear

Clear all

Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.

Actions [ Add Action
Add View To Existing Action
Display Actions That Indude This View

Transpose - Use this option to change the axis for levels and measure items in the grid. Objects
displayed in columns are switched to display in rows and vice versa.

View Explorer - This option allows you to open and close view explorer. If the Properties window is
open when you close view explorer, the Properties window will also close.

Properties - Click to maintain the level properties including the filter, sort, totaling, visibility, and
display text.

Copyright 2020 Silvon Software, Inc. A/l rights reserved. (Last Revised. December 2020) 11



View Name Pop-up Menu

Right-click the view name to display actions that you can take related to the overall grid, such as exporting to Excel.

Delete

Actions 3
Excel
Print

Properties

Delete - Choose Delete to delete the view with confirmation. Anyone can delete their own personal
views, but only view and security administrators may delete global views.

Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.
Adtions 3 Add Action
Add View To Existing Action
Display Actions That Indude This View

00 00C

Excel - Click to initiate an export of the view to Microsoft Excel.
Print - Click to print the active page of the view.

e Properties - Click to maintain the view properties including the name, description, type and view
group.

Properties Window for Attribute Relationships

Properties - UPC List Catalog Number *
Mame: |UFC List Catalog Mumber o |
Caption Expression: |CEI|SEI|DEI Mumber |

Sort: Mone 2
Visible: Yes

o Fill Color | | -]

o Name — The name of the attribute. Used in the view explorer and filter windows.

Caption Expression — A read only field that shows the expression behind the caption for an attribute
relationship. The resolved text generated by the expression creates the caption, which is the text that
displays for the attribute relationship in the view. The Caption Expression window can be accessed for

editing the expression by clicking the Browse button EI next to the field. Attribute relationships will be
referred to by their names in all other Stratum.Viewer locations that they appear, such as in view
explorer and the Select Members window.

e Sort - Use to add, edit, or remove Ascending and Descending sorts.
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Visible — Set this property to No to hide the attribute relationship in a view. Set this property to Yes to
display the attribute relationship in a view.

Fill Color — Assign a fill color that will be used in the row or column containing the attribute

relationship. This makes it stand out from the rest of the grid. Click the Browse button E next to the
Fill Color property to choose a color from the Color window. Or, if there is already a color selected and
you don’t want a fill color used anymore, select the No Fill checkbox.

Properties Window for Individual Measure Iltems

Regular Measure Items

H Mame: |Datal
(2 o~
Measure: |Actua| Sales Sales Amount
Iwﬂ String: As Is
Fill Color |

F Visible: Yes

Properties - Actual Sales Sales Amount Wk 1 17toWk 1 17 *

Caption Expression: |[Measure] [From Pericd Short Desc] [From Year Y] tc|

o Value: |Yes
Image: No
Conditional Format: ‘I‘E5|SE|IE5 less than 100K

Pop-up Expression: ‘I'ES
Hyperlink: MNa |

"Red indicator represents when sales are belo

e b b [l [€]l &

o Filter: Recursive Top Count |15

Sort:  Descending

Total: |Total e

<<

Name — The text in this field determines the unique name that Stratum.Viewer will use to identify a
measure item in the view. You can edit this field as needed. Default names given to new measure
items are DataN. The “N” is a sequential number assigned by Stratum.Viewer to create a unique
name. You will be prompted to make corrections to the name if you enter a duplicate name, use any
spaces in the name, use too many characters (more than 50), or use invalid characters.

Caption Expression - A read only field that shows the expression behind the caption for a measure
item. The resolved text generated by the expression creates the caption, which is the text that
displays for the measure item in the view and other areas of the application such as view explorer.
The Caption Expression window can be accessed for editing the expression by clicking the Browse
button next to the field.
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Type — This property shows the type of measure item you are working with — either regular,
calculated, or distinct calculated. The property will be set to “Regular” if you are inserting or editing a
regular measure item.

Note: See the next table for information about calculated and distinct calculated types.

Measure — This field is a read only field that displays the underlying measure you selected when
setting up the regular measure item.

e For measure items with time ranges, clicking the Browse button Lo next to the Measure
field opens the Edit Measure Item window. Use that window to edit the measure item's
underlying measure or time range. The main Time Range property for a view must be set to
Yes for the Properties window to behave in this manner.

e For measure items without time ranges, clicking the search button Q next to the Measure
field opens the Select Measure window for editing the underlying measure. The main Time
Range property for a view must be set to No for the Properties window to behave in this
manner.

Format String — Use this drop-down list to apply a format such as decimal places, monetary
symbols, commas, or a combination of formatting.

Fill Color — Assign a fill color that will be used in the column or row containing the measure item.

This makes it stand out from the rest of the grid. Click the Browse button |_| next to the Fill Color
property to choose a color from the Color window. Or, if there is already a color selected and you
don’t want a fill color used anymore, select the No Fill checkbox.

Value — Determines if the measure item value displays in the Viewer grid. Set to Yes to display
value. Set to No to hide the value, for example, in cases where you want to display only the
conditional format icon for a measure item.

Image — This property is used when setting up calculated measure items that display images. See
the next table for information about this property.

Conditional Format — Controls the display of icons, and cell and text formatting for the measure

item by applying the conditional format rules. The Browse button |_| is only enabled when the
Conditional Format field is set to Yes. When enabled, you can click the button to access the Select
Conditional Format window to edit the conditional format associated with the measure item or create

a new one. The name of the selected conditional format displays in the text box left of the |_| icon.

Pop-up Expression — Use this property to specify whether the selected measure item has a pop-up
label that will display when you hover over the measure item value, indicator, or image. The Browse

button |_| is only enabled when the Pop-up Expression field is set to Yes. When enabled, you can
click the button to access the Pop-up Label Expression window to edit the existing expression or

create a new one. The active pop-up expression displays in the text box left of the |_| icon.
Hyperlink — Choose Yes if you want a hyperlink defined for the cell of a measure item. The Browse

button |_| is only enabled when the Hyperlink field is set to Yes. When enabled, you can click the
button to access the Hyperlink Expression window to edit the expression or create a new one. The

hyperlink defined displays in the text box left of the |_| icon.

Visible — Set this property to No to hide the measure item in the view. Set this property to Yes to
display the measure item in the view.

14

Working with Sorts




drop-down list and enter the value to filter by in the field next to the list. Pop-up labels showing filter

e Filter and Sort — Use to add, edit, or remove filters and sorts. For filters, select the operator from the
criteria will show for the Filter field after a filter has been applied.

If your view has levels on the same axis as measure items, these properties will be disabled until you
have applied an initial filter or sort via the grid.

Total — Use to control the type of total that is performed for a measure item. The default setting for all
measure items is Total.

e None — No total will be displayed.

e Total — This designation takes into account any underlying calculations for a measure item’s
definition when generating Grand Totals, sub-totals, and All Others — such as calculations
defined in a measure item expression or associated with a Stratum.Planner calculated value.

e Sum - This designation means that Viewer will generate totals by adding the values
displayed in measure item detail cells. That summing will be used to generate the Grand
Totals, sub-totals, and All Others. This type of total is intended for special cases where you
don’t want any of the underlying calculations that Viewer performs to be used when
generating total values. You might choose to use a Sum total when a measure item
calculation includes an IIF statement, such as a calculation with IF, Then, Else conditions.

Calculated and Distinct Calculated Measure Items

X

Properties - Percent of Total Growth

b Mame: |Da|ta|§r
Caption Expression: |F‘eroenl: of Total Growth
kﬁrpe: Calculated

Expression: |[Measures].[[)al:a.5 (%% of Total)] - [Measures].[Datas |

Format String: |#,###.000%

<l

K| K 0 R Y E R 9 K |

Fill Color |

WValue: Yes
Image: Mo

Conditional Format: Yesﬂ |F‘eru:er1t of Total Growth

Pop-up Expression: Yesﬂ |#Measureltem{""u'alue"]

Hyperlink: Mo ﬂ|

w— Visible: Yes
Filter: ﬂ|
o Sort: Mone
Total: MNene e

Name — The text in this field determines the unique name that Stratum.Viewer will use to identify a
o measure item in the view. You can edit this field as needed. Default names given to new measure
items are DataN. The “N” is a sequential number assigned by Stratum.Viewer to create a unique
name. You will be prompted to make corrections to the name if you enter a duplicate name, use any
spaces in the name, use too many characters (more than 50), or use invalid characters.
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Caption Expression — A read only field that shows the expression behind the caption for a measure
item. The resolved text generated by the expression creates the caption, which is the text that
displays for the measure item in the view and other areas of the application such as view explorer.
The Caption Expression window can be accessed for editing the expression by clicking the Browse
button next to the field.

Type — This property shows the type of measure item you are working with — either regular,
calculated, or distinct calculated. The property will be set to “Calculated” or “Distinct Calculated” if
you are inserting or editing that type of measure item.

Note: See the previous table for information about regular types.

Expression — When "Calculated" or "Distinct Calculated" is the measure item type, an Expression
field shows in this window. It's a read only field that shows the expression for calculating the measure
item. The Expression window can be accessed for editing the expression by clicking the Browse

button ) next to the field.
Note that when you are using a calculated measure item to display images in a view that the
expression will determine the location/name of the image file for Stratum.Viewer to display.

e The image file must reside in the Stratum.Viewer application folders. It is recommended that
all custom images reside in a subfolder of the Images folder of the Stratum.Viewer
application.

e Supported file types for images are *.jpg, *.jpeg, *.png, *.bmp, *.gif, *.tif, and *.tiff.

e The image will display according to its original, default size.

Format String — Use this drop-down list to apply a format such as decimal places, monetary
symbols, commas, or a combination of formatting.

Fill Color — Assign a fill color that will be used in the column or row containing the measure item.

This makes it stand out from the rest of the grid. Click the Browse button |_| next to the Fill Color
property to choose a color from the Color window. Or, if there is already a color selected and you
don’t want a fill color used anymore, select the No Fill checkbox.

Value — Determines if the measure item value displays in the Viewer grid. Set to Yes to display
value. Set to No to hide the value, for example, in cases where you want to display only the
conditional format icon for a measure item.

Image — This property is used when setting up calculated measure items that display images. You
use the Expression window to define the location of the image and then set this property to Yes in
order for the defined image to display in the grid. See item 2 above.

Conditional Format — Controls the display of icons, and cell and text formatting for the measure

item by applying the conditional format rules. The Browse button |_| is only enabled when the
Conditional Format field is set to Yes. When enabled, you can click the button to access the Select
Conditional Format window to edit the conditional format associated with the measure item or create

a new one. The name of the selected conditional format displays in the text box left of the |_| icon.

Pop-up Expression — Use this property to specify whether the selected measure item has a pop-up
label that will display when you hover over the measure item value, indicator, or image. The Browse

button |_| is only enabled when the Pop-up Expression field is set to Yes. When enabled, you can
click the button to access the Pop-up Label Expression window to edit the existing expression or

create a new one. The active pop-up expression displays in the text box left of the |_| icon.
Hyperlink — Choose Yes if you want a hyperlink defined for the cell of a measure item. The Browse
button |_| is only enabled when the Hyperlink field is set to Yes. When enabled, you can click the
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button to access the Hyperlink Expression window to edit the expression or create a new one. The
hyperlink defined displays in the text box left of the E] icon.

Visible — Set this property to No to hide the measure item in the view. Set this property to Yes to
display the measure item in the view.

Filter and Sort — Use to add, edit, or remove filters and sorts. For filters, select the operator from the
drop-down list and enter the value to filter by in the field next to the list. Pop-up labels showing filter
criteria will show for the Filter field after a filter has been applied.

0

If your view has levels on the same axis as measure items, these properties will be disabled until you
have applied an initial filter or sort via the grid.

Total — Use to control the type of total that is performed for a measure item. The default setting for all
measure items is Total.

e None — No total will be displayed.

e Total — This designation takes into account any underlying calculations for a measure item’s
definition when generating Grand Totals, sub-totals, and All Others — such as calculations
defined in a measure item expression or associated with a Stratum.Planner calculated value.

e Sum - This designation means that Viewer will generate totals by adding the values
displayed in measure item detail cells. That summing will be used to generate the Grand
Totals, sub-totals, and All Others. This type of total is intended for special cases where you
don’t want any of the underlying calculations that Viewer performs to be used when
generating total values. You might choose to use a Sum total when a measure item
calculation includes an IIF statement, such as a calculation with IF, Then, Else conditions.

Properties Window for Levels

Properties - UPC Global Mumber b

Mame: |L.|F‘C Global Mumbear

Caption Expression: |L.'F‘C =

Filter Mode: | Include

Filter: | Membars
Sort: | None

Total: | Yes

All Others:

Visible:

¢ < < < <[i] <
& ©

o Name — Name of the level. Used in the view explorer and filter windows.

Caption Expression — A read only field that shows the expression behind the caption for a level.
The resolved text generated by the expression creates the caption, which is the text that displays for
the level in the view. The Cﬁion Expression window can be accessed for editing the expression by

clicking the Browse button next to the field. Levels will be referred to by their names in all other
Stratum.Viewer locations that they appear, such as in view explorer and the Select Members window.
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Filter and Sort - Use to add, edit, or remove filters and sorts.

o Filter Mode — This property controls how Viewer treats a member list, user list, expression,
or named set filter. The “Include” option means the applied filter returns only the members
specified by your filter selections/criteria. “Exclude” means the applied filter returns all
members except the ones specified by your filter selections/criteria.

e Filter - click the Browse button EI to access the Select Filter Method window and either add
or change a filter. If a filter already exists, the filter type displays in this field and a pop-up
label shows filter criteria.

e Sort - use the list provided to add Ascending or Descending sorts or to change or remove a
sort.

Total — Use to control whether or not Total values display for the level. When the property is Yes,
totals will display for the level, When the property is No, totals will not display.

All Others — Use to control whether or not All Others values display for the level. All Others values
represent the sum of all members not in a filter. When the property is Yes, All Others values will
display for the level, When the property is No, All Others will not display.

Visible — Set this property to No to hide the level in a view. Set this property to Yes to display the
level in a view.

Display Text — This property controls what displays in the first row or column for the level. The
default is the level value. You can change it to any of the attribute relationships that have been made
available in the view for the level.

Fill Color — Assign a fill color that will be used in the row or column containing the level. This makes

it stand out from the rest of the grid. Click the Browse button EI next to the Fill Color property to
choose a color from the Color window. Or, if there is already a color selected and you don't want a fill
color used anymore, select the No Fill checkbox.
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Advanced Concepts

Calendar Based Sorting

Calendar based objects are objects related to time, which are time hierarchies and their levels. Examples of time
hierarchies and levels are Year Based Months Based, Rolling Year Based Months Based, Year Months, and
Months. Sorting on calendar based objects is based on their calendar order. By default, the objects are displayed in
order of oldest to most current. You can apply a descending sort to arrange objects from most current to oldest. To
return the order to the default sequence, either apply an ascending sort or remove the sort all together. Sorting acts
the same whether you sort the time member's value or attribute relationship.

A few examples follow.

e Absolute Time
e Based Time

View Explorer

4 . Calendar Based Sorting
, Parameter Groups
4 | Grd
| Rows

4 | Columns
4 T4 vear Based Months Based
* ‘Year Based
= Months Based
12, Ralling Year Based Months Based
* Year Based
= Months Based
17, Year Months
* Year
= Months
12, Manths
= Months
View Filter

1Y

[

b
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Absolute Time
Example 1

The Year Months hierarchy is on columns and Months hierarchy is on rows in the following view. No sorting has
been applied yet.

EII+ View Name: Calendar Based Sorting
4|~ View Filter

Year > 2012 2013 2014

Mont} Actual Sales Actual Sales Actual Sales Actual 5ales Actual 5ales Actual 5ales

- Units Amount Units Amount Units Amount
January 5,007,078 $280.571.491 11579068  $650,655,727 6,258,847  $350,714,364

4660289  $257.865.913 9929320  $549.211669 5825361  $322,332,391
March 5,242,572  $288,803.899 11862018  $652,242,257 6553215  $361,004,374
Apri 4744533 $262,246245 11,733,747 5645861506 6867712  $327,807,306
May 4991233 $277,181642 8413481  $468934747 7,798,802  $352,020,685
June 5287949  $295804171 12242975  $682957,762  B910,194  $§375,671295
Juby

August

g
E

6008177  $334309311 17,933,690 5997610460 9613083  %301,977.666
7071967  $394294470 13414447  $755754978 12744274  $485,764,510

September 7,739,349  $435840359 11,125528  $627.060,751 12,093,515  $569,861272
October 6.152,790  $364922428 6581900  $394,333,371
Movember £917.943 8421277384 6093220  $367.487.985
December 3,740,752 $227.090225  3,624.759  $220,048,674

Grand Total|_67.575,132] $3.840207.508] 124534163] s7.012.160085] 76,665,003] $3.597,154864

A descending sort is applied to the Year level on columns, changing the order from 2014 to 2012. A descending
sort could be applied to Months on rows too, if needed, and that would change the order from December to
January. In this case, the order has been left at the default of January to December.

EXZ+ View Name: Cafendar Based Sorting
4|—+ View Filter

{ hd 2014 2013 2012 )
Year == — — —

Actual 5ales Actual Sales Actual 5ales Actual 5ales Actual 5ales Actual 5ales

Months Units Amount Units Amount Units Amount
Tarwsary 6,258,847  $350,714364 11,579,068  $650,655727 5,007,078  $280,571491
February 5825361  $322,332391 9929320  §$549.211,669 4660289  $257,865913
March 6553215  $361,004,874 11,862,018  §652242257 5242572  §288,803,899

April 6,867,712  $327,807.806 11,733,747  $645861,506 4744533  $262,246,245
May 7,798,802 $352,020685 8413481 468,934,747 4991233  §277,181642
June 8910194  $375671,295 12,242975  $682,957,762 5287949  $295804,171
July 5613,083  $351977.666 17933690  $997610460 6008177  $334,309311
August 12,744274  $485764510 13414447  §755754978 7071967  §394,294.470
September 12,093,515 $569,861,272 11,125,528  $627,060,751 7,739,845  §435.840359

October 6,581,900 £304 333 571 6,132,790 $364,922 428
November 6,005,229 §357,487,985 6,527,543 421,277,394
December 3,624 759 £220,048.674 3,740,752 £227.090,225

|Grand Total|_76,665,003] $3537,154864] 124,534,163 $7,012,160,085] 67.675,132]
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Example 2

There are two levels from the Year Months hierarchy showing in this view. No sorting has been applied yet. The
Year level has been filtered to display the years 2012 through 2014.

EEZ+ View Name: Calendar Based Sorting
4|~ View Filter

T Year Months Actual Sales Units Actual Sales Amount
2012 January 5,007,078 $280,571,451
February 4 660, 289 5$257,865,913

March 5,242 572 5288.303 355

Apri 4,744 533 $262,246,245

May 4,991,233 §277.181,642

June 5,287,945 $295.804,171

Ju 6,008,177 $334.300311

August 7,071,967 $394.294 470

September 7,735 845 5435 840355

October 6,152,790 $364.922 428

Hovember 6,927.043 5421277354

December 3,740,752 227,090,225

2012 Total 67,575,132 $3,840,207.548

2013 January 11,579,068 $650,655,727
February 9,926 320 5549 211 669

March 11,362,018 $652,242,257

Apri 11,733,747 $645 361 506

May 8,413,481 $468.934,747

Taur i 17 247 Q75 RRTT O5T7 T87
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A descending sort on Months changes the order of months for each year from the most current of December back
to the oldest month of January.

EZZ+ View Name: Calendar Based Sorting
4|~ View Filter
T Year r ¥ Months\%ctual Sales Units Actual Sales Amount
2012 December 3,740,752 $227.000,225
Movember 6,927,943 $421,277,394
October 6,152,790 5364522 428
September 7,739,849 §435,840,359
Auqust 7,071,867 304,204 470
Juby 6,008,177 $334,309,311
June 5.787.848 265 804,171
May 4951233 $277,181,642
Apri 4744 533 §262,246.245
March 5,242,572 $288,803,899
February 4,660,289 5257865913
January 5,007,078 $280,571,491
2012 Total 67,575,132 $3,840,207,548
2013 December 3,624,755 $220,048,674
Movember 6,093,219 $367.487.985
October 6,581,900 $394,333,571
September 11,125 528 $627.060,751
\%_/ 13 414 447 §755,754,978
Tuhs 17993 59 5007 /10 460
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A descending sort on Year changes the order of years to the most current of 2014 to the oldest year, which is 2012.
The current month for 2014 is September, and that is why the months of December, November, and October do not
have any data yet.

Note: For period based views that use time hierarchies, it is recommended that you set the Relationship Filter and
Empty Filter properties to No for the axis where the time hierarchies are used. In this example, both properties were
set to No for rows. This will ensure that all periods will display in the view, even those for which no data exists. For
example, if both properties had been set to Yes for the rows in this view, then the rows for December through
October of 2010 would not have displayed.

EIZ+ View Name: Calendar Based Sorfing
4|~ wiew Filter
¥ T Year| ¥ Months Actual 5ales Units Actual Sales Amount
December
HNovember
| October
| September 12,093,515 £569,861,272
| August 12,744274 485,764 510
Juby 9 613 083 $301,577 666
June 8,510,184 375,671,285
May 7,798 802 $3352,020,685
April 5,867,712 327,807,506
March 6,553 215 5361,004,874
| February 5,825,361 322,332,381
\January 6,258 847 $350,714,364
2014 Total 76,665,003 §3,537,154,864
December 3,624 759 5220048674
Hovember 6,063 2209 53567 487583
October 6,581,900 $394,333,571
September 11,125,528 627,060,751
August 13,414 447 §755,754.978
Tuhe 17,933 400 £007 A10 450
Based Time
Example 1

The next view has the Year Based Weeks Based hierarchy on rows. The first level, Year Based, is displayed and it
is sorted in ascending order. The oldest year of 3 Years Ago shows first.

E"' View Name: Calendar Based Sorting
4|~ View Filter

67,575,132 $3,840,207,548
123,809,211 $6,968,150,351
77,389,955 $3,581,164, 599

Last Year
Current Year
[lext Year 2015

Gadtotall | o] suswsmaw
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Example 2

This view has the Rolling Year Based Months Based hierarchy on rows. Both the Year Based and Months Based

levels are displayed. There is already a descending sort on the first level.

4|~ View Filter

Current Year

Months Based

6 Manths Ago

Last Year

J

5 Months Ago
4 Months Ago
3 Months Ago
2 Months Ago
Previous Month
Current Month

Current Year Total

6 Months Ago
5 Months Ago

4 Months Ago
3 Months Ago
2 Months Ago
Previous Month
Current Month
Mext Month

2 Months Qut
3 Months Out
4 Months Out
5 Months Out

Last Year Total

| Gandvotal] | | 1mssumn|

EXZ+ View Mame: Cafendar Based Sorting

Rolling Year Based Months Based-Months Based  Actual Sales

2014/March
2014{8pril
2014/May
2014/June
2014/ uby

2014/ August
2014/September

2013/March
2013/April
2013/May
2013/ June
2013/ Juby
2013/August
2013/September
2013/0ctober
2013 November
2013/December
2014lanuary
2014/February

-Abs Months

Linits
6,553 215
6,867,712
7,798,802
8,910,194
9,613 083
12,744 274
12,0093 515
64,580,794
11,862 018
11,733,747

3,413 481
12,242 975
17,933 690
13,414 447
11,125,528

6,581,900
6,093,229
3,624,750
6,258,847
5,825,361

115,109,984

Actual Sales
Amount

$361,004, 874
§327,807,806
$352,020,685
§375,671,295
$391,877 666
$485 764,510
$569,861,272
§2,864,108,109
$652,242,257
5645 861,506
$468 934 747
$682,957.762
$597 610,460
§755,754 978
$627,060,751
$304 333 571
$367 487 983
$220,048 674
$350,714 364
$322332.391

56,485,339, 445
$9,349,447.554
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A descending sort is applied to the attribute relationship for the Months Based level. This arranges the Months

members within each year from the most current to the oldest month.

4|~ View Filter

Months Based [T Rolling Year Based Months Based-Mont
- Based-Abs Months

EXZ+ View Mame: Cafendar Based Sorting

~

hs

¥ T Year
Based

Current Year Current Month 2014/September
Previous Month 2014/ August
2 Months Ago 2014/ Juby
3 Months Ago 2014/June
4 Months Ago 2014/May
5 Months Ago 2014/April
6 Months Ago 2014/March
Current Year Total

Last Year 5 Months Out 2014/February
4 Months Out 2014/ January
3 Months Out 2013/December
2 Months Out 2013/November
Next Month 2013/0ctober
Current Maonth 2013/September
Previous Month 2013/August
2 Months Ago 2013/ uby
3 Months Ago 2013/June
4 Months Ago 2013/May
5 Maonths Ago 2013/8pril
& Months Ago Q}_LS,F March

Last Year Total

Actual Sales
Uinits
12,083,515
12,744274
5,613,083
8,910,194
7,798,802
6,867,712
6,553,215
64,580,794
5,825,361
6,258,847
3,624,755
6,093,229
§,581,900
11,125,528
13,414 447
17,933 690
12,242,975
8413 481
11,733,747
11,862,018

115,109,984

Actual Sales
Amount

$569,861,272
$485,764.510
$391,577.666
$375,671,265
$352,020,683
$327,807.806
$361,004,874
§2,864,108,109
$322.332,391
$350,714 364
$220,048 674
$367 487985
§354,333,571
$627,060,751
§755,754,978
$997 610 460
$682,557,762
$468 934 747
$645,861,506
$652,242 257
$6,485,330,445

| _Gandvoal] | 00000000 | e m| ssasaarss
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Guidelines for Sorting and Filtering on Totals
Here is some helpful information to know when sorting or filtering totals.
e Casual users can edit existing sorts and filters on totals.

e Advanced users and administrators can add new sorts and filters on totals and edit existing sorts and
filters.

e This feature is available on the Grand Totals that are on the same axis as the measure items. For example,
the measures items in this view are in columns. The Grand Totals in columns can have sorts and filters
applied to them.

[:_I E}: é E}_l_ .Q‘ Y @ m |I| @ 6°°e1to-|nnf2055|moomnmlﬁnfm [Viewer V]
EXZ+ View Name: Returns by Lof. Reason Code
ﬂj View Filter
Rmi Il::.r-nn 624 625
mm Damaged Product Price
Lot Current ¥ ¥TD Months Previous Y YTD Current ¥r ¥TD Previous
- Return Amt Months Return Amt Months Return Amt Months Feturn
19990101914001 ($475) (S448) (52899
19990101914002 ($439) (8433) (5280
19990101914003 ($629) (8593) ($383)
19990101914008 ($2,329) (52,665) ($1,719)
19990101914304 (81,521 ($1,812) (81,169
19990101914422 ($2,282) (52,133) ($963)
19990101914602 ($1,024) (8966) ($1,068)
19990101914603 (5690) ($631) 56T
19990101914604 ($238) (5224) ($101)
19990101924003 ($3,279) ($4,980) (82,640
19990101924015 ($1,046) (3987) (36373 SA0 %7 19M
| 19990101974401 56 1541 (53 R06) 54 /53 fid 390 544.415) (541907
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Can Multiple Objects be Sorted in Views?

In some cases, multiple objects can be sorted. More than one level can be sorted in the same view, but only one
measure item at a time can be sorted in a view.

See also: Why were Sorts Removed from Measure Items?.

In this example, there is a sort on the level in columns and a sort on an attribute relationship for the level on rows.

EIZ+ View Name: Daily Sales by RepBroker and Country
4|~ view Filter

¥ Customer Ship-To USA
Country >>

Daily Sales Daity Sales Daity Sales Daily Daity Sales Daily Sales Daily Sales Daity Daity Sales Daily Sales D

roboer ( o Amount Sales Units Amount Sales Units Amount

SETELER A RepBr Long Description) wk 38 2014 to Wk 38 Wk382014to Wk Wk 37 2014 to Wk 37 Wk372014toWk  Wk36 2014 to Wk36 Wk
2014 38 2014 2014 37 2014 2014

308 Dean Cizek e §2,937 438 $187.361 1,119 $35,950

313 Eleanor Toman $10.765 1.802 $686,799 4 606 131,779

307 Guy Nelson 51,124 198 571,684 305 513,754

305 Janice Tierney 49,835 1422 5627490 3,633 £120,35%

306 John Trainor

304

302

1chn Trasky $3,392 639 §229.153 1,685 $43.969
Mw_/ $6.201 1.072 §385.636 2,738 §75.913
In this example, there is a sort on the Sales Units measure item.

[Ei+ View Name: Monthly Sales Views fiftered by Product Group
412/ View Filter ¥ Product Group)

T Year Based == Last Year Current Year

Year Based Months Based-Year Based-Abs Year 2013 2014

Months Mﬂﬁt Sales Units Mﬂﬁt r A& Sales Units)
October £134,726 370 2325511
November £120,630,704 2,057,686
December £75669.211 128128R
January £191 238 484 3486263 593,102,611 1,695 884
February §166,186,115 3035288 $07.153,548 1,782,815
March $170,458,747 3141045 599415303 1,828,058
April £180,174,622 3359940 5103 686,072 2,232,093
May £152.231,793 2 821820 $110.814 550 2,541,088
June 204244 740 3787346 5117183692 2,889 562
Juby $2B13B3,297 5152400 $120,192 437 3,022320
M §242 788266 4445061 85137459746 3,672,251
September 8189546211 3484795 5180,593 183 3,963.6

Copyright 2020 Silvon Software, Inc. A/l rights reserved. (Last Revised. December 2020) 27



Applying a sort to the Sales Amount measure item removes the sort that had been on the Sales Units measure
item.

EXZ+ View Mame: Monthly Sales Views fiftered by Product Group
4|2 View Filter T product Group

$75,669.211 1281288 \ Vi

T Year Based == Last Year Current Year

Year Based Months Based-Year Based-Abs Year 2013 2014

Months hsr?;ﬁ?-lt Sales Units r :njli!l? \ Sales Units
September 189 546 211 3484 795| 5180593 133 3963651
August $242,788.266 4.446.061| $137.459.746| 3.672.251
Juby 281383297 5152400] 5120192437 3022329
June $204,244.740 3,787346| $117.183,692| 2.889,562
May §152231,783 2821 82%| 5110814555 2541088
April $180,174.622 3.359.940| $103.686072| 2,232,003
March 5170458747 3141045 690415393 1,323,058
February $166,186,115 3,055,288 §97,153,548| 1,782,815
January 5151 238 484 3 486 263 $63.102, 611 1,695 884
October $134,726,370 2,323,511
MNovember $120,630,704 2057 686
December

Do Sorts Impact Measure Items with Conditional Formatting including Images and
Indicators?

Yes. When a measure item with an associated image or indicator is sorted, the value of the measure item is used in
the sort. The image and indicator are ignored by the sort.

Why can’t | Filter or Sort Cumulative Calculated Measure Items?

The results of a cumulative calculation are accumulating in nature; therefore, sorting and filtering functionality is not
available on calculated measure items that use cumulative functions in their expression. Those functions include
the Cumulative Total, Cumulative Percent of Total, ABC Cumulative, and ABC Cumulative Percent of Total
functions.

e Sort and Filter options will not display on the pop-up menu of a calculated measure item that uses a
cumulative function.
Sort and Filter properties will be disabled in the Properties window for those measure items.
Filtering those types of measure items will not be permitted when using the Data tab of the Filters window.
¢ If a non-cumulative calculated measure item has been sorted or filtered and you want to change it to a
cumulative calculated measure item, you must first remove the sorting or filtering.
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The view that follows shows an example of this scenario. The “Percent of Total” calculated measure item can be
sorted and filtered because it does not perform a cumulative calculation. The “Cumulative % of Total” calculated
measure item cannot be sorted and filtered.

EEZ+ View Name: RepBroker Cumulative Sales
4|~ View Filter
T RepBroker Product Category ] & Actual Sales | percent of Total Cumulative % of Total
an 2014 to Sep 2014
Mary Lopezr Frozen Fruit Products 53,029,230 B0% S0%
Pork $7,651 423 1.37% 227%
Beef $11,814,56: 2.11% 438%
Frozen Prepared Dinners 815,690,974 2.81% 7.15%%
Fresh Fruit 519,235,671 344% 10.63%
Canned Fruit §25,735,340 4.60%% 15.23%
Fresh Vegetables §27,251,06] 487 20.11%
Mary Lopez Total $112,408,36€
Eleanor Toman  Frozen Fruit Products 55,455,123 1.65% 21.80%
Paork §17,749.079 317 24 97%
Beef $18,508,033 3.38% 28.36%
Fresh Fruit $32,031,42¢ 3.73% 34.09%
Frozen Prepared Dinners 544 281,161 T 8% 42 01%
Fresh Vegetables 547,904,721 B3.5T% 50.58%
Canned Fruit 8276,258,20] 45 42%, 100.00%
Eleanor Toman Total S446,627,746 S y

Here's the pop-up menu for Percent of Total, with the Sort and Filter options:

Copy
Select All Occurrences

Select all

Add ]
Edit
Delete

Hide

Sort ¥
Filter

Conditional Format b
Actions
Transpose

View Explorer

Properties
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Here's the pop-up menu for Cumulative Percent of Total, without Sort and Filter options:

Copy
Select All Occurrences

Select All

Add »
Edit
Delete

Hide

Conditional Format »
Actions »
Transpose

View Explaorer
Properties

The “Percent of Total” calculated measure item in the next view has a Recursive Top Count filter applied to it. If you
attempted to change the expression for “Percent of Total” to a cumulative percent of total, a message would display
stating that you need to remove the filter before the cumulative function can be applied to the expression.

EIZ+ View Name: RepBroker Cumulative Sales
4|+ View Filter
Recursive Top Count 5
T RepBroker Product Category ] A Actual Sales Percent of Total Cumulative %% of Total
an 2014 to Sep 2014
Mary Lopez Fresh ¥ bles §27.251,065 ;5 4.87% £.37%
Mary Lopez Total §217,251,065
Eleanor Toman  Fresh Fruit 532,031,428 5.73% 13 86%
Frozen Prepared Dinners 544 781,151 792% 2421%
Fresh Vegetables 547504721 3.57% 3541%
Canned Fruit $276,298,202 45 42% 10000
Eleanor Toman Total £400,515,511
I T R R

Why is a Sort Property Disabled?
This can happen when:

e You're a casual user.

e You're working with a cumulative calculated measure item.

e You're working with measure items and there are levels on the same axis as level items.

e You are trying to sort Grand Totals that are on the axis opposite from the measure item axis. See
Guidelines for Sorting and Filtering on Totals.

Casual User

The grid pop-up menu for casual users does not have a Sort option on it. Casual users are only able to edit existing
sorts by clicking the sort icon (& or ¥) next to the sorted level, attribute relationship, or measure item.

30 Working with Sorts



Cumulative Calculated Measure Item

Sorting is not permitted on calculated measure items that use cumulative functions in their expression. Those
functions are the Cumulative Total, Cumulative Percent of Total, ABC Cumulative, and ABC Cumulative Percent of
Total functions. The Sort option will not display on the grid pop-up menu of a calculated measure item that uses a
cumulative function. Also, the Sort property will always be disabled in the Properties window for those measure

items.
EEI+ View Name: Cwmulative Current Week Sales Units
4| View Filter
Currm\'ﬂkﬁm Curreﬁng Sales Cumulative -\\
Product Family  \yy 35 14 vd w3 (Wk 38 14 to Wk 38 C”"E"Lt'r'l'i"t';‘ Sales
14) Copy
Frozen Entrée 8§ Select A Occurrences 63,445
Frozen Indnidual Dinner sp,  SelectAl 131,606
Tender Vegetables 113 . 276,070
Hardy V. bles 5§, Edit 388 467
Eruit Filings 13 Remove 573,263
Applesauce s}. Hide 716,525
Frozen Juice 55, 762,111
Spedalty Canned Fruit ST, Conditional Format 879,825
Fruit Cocktail 5y Adons 1,051,458
Transpose

Peaches 81§, 1,295,223
Pears S§. View Explorer 1,409,209
Pineapple 5..;\_ Properties LSS?W
Fresh Pork $5,188 822 77286 1,654,925
Fresh Beef $4.608 416 76,236 1,711,161
Tender Fruits $5,994 606 93,073 1,804,234
$5,090,158 130,728 1,934,962
_

(Sort

4 || Cumulative Current Week Sales Units

. Parameter Groups
4 | Grid
[ 1. Rows
. Columns
.. View Filter
4 | Measure Items
Current Wk Sales Amount (Wk 38 14 to Wk 38 14)
Current Wk Sales Units (Wk 38 14 to Wk 38 14)
E@ Cumulative Current Wk Sales Units
| Presentation
. Charts
PI‘I:IDEI'I:IS Cumulative Current Wk Sales Units =
e Dog e (]
Value Yes )
Image No
Conditional Format |I'I.In V“ ...
Pop-up Expreassion |I'I.In V“ |
Hyperlink |I'I.In V“ ...
Visibla Yas
Filter b

Q

3

[<]
&

Total None
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Levels on Same Axis as Measure Items

If there are levels on the same axis as the measure items, then Sort will be disabled in measure item Properties
windows. You must first sort the measure item via the grid in relation to a particular level member on the measure
item axis.

In this view, the measure items are on the columns axis and there is an ABC Classification Code level on columns.
The Sort property is disabled in all measure item Properties windows. You can sort by right-clicking an instance of a
measure item in the grid (for A, B, or C code) and using the Sort option on the pop-up menu.

After setting up the initial sort that way, the Sort property will be enabled in the Properties window. You can then
edit or remove the sort from the grid or Properties window.

HIECEiE &Y B @ BO0D 1017017 | DOOD 11010012 Viewer
EiZ+ View Name: Cumelative Current Week Sales Units View Explorer x
ﬂj View Filter
4 | Cumulative Current Week Sales Units
ABC Classification A B .. Parameter Groups
Code ==
4 . Grid
ABC Long
Description A E .. Rows
Current Current ~ Columns
Current Wk Currgnt Wk Cu . View Filter
Wk Sales  Sales Cumulative Wk Sgles Sales Cumulative Wk
Amount  Units  Current  Amognt  Units  Current  Am 4 [, Measure ltems
(Wk38 14 (Wk38 WkSales (Wk3814 (Wk38 Wk3Sales (Wk Current Wk Sales Amount (Wk 38 14 to Wk 38 14)
toWk38 14to Units toWH3E 14to Units tol
Copy 18 14 Wk 38 1 Current Wk Sales Units (Wk 38 14 to Wk 38 14)
Select All Occurrences 14) B cumulative Current Wk Sales Units
Select All 4 65,445 . Presentation
Insert R §6,08],122 66,161 66,161 | Charts
Edit 96 164,341 53
B 45 197486 §135]435 33612 99785 §24
18 319304 S§1.108.667 18,794 S-SRI Properties - Current Wk Sales Units (Wk 38 14 to Wk 38 1: X
2 66 462,570 Mam= Data2
= 531 ) i . -
_ Ascending Caption Expression Current Wk Sales Units ([From Period Shor!lzl
Descendingly POp773 35,165 173743 i
| o _ Type Regular
Clear 74214 171533 345276
Cor:n:ihond Format '7511 331 208076 553352 Measure Actual Sales Sales Units El
Adtions H__ Qe Al hod 563 113986 667,339 Format String As s
Transpose S : ’
15 567694 $5874239 124515 791853 value es
View Explorer §1,743,899 23266 817,119 83! Image Mo
Properties
P 03 381,797 J $2¢| | Conditional Format |Nu b || [
Tender 3 4,730 67,340 B84,639 5L Pop-up Expression |Nu bt || |
§2.519.205 65178 949337 %2 - | I |
Hyperlin Mo W
i v susasmfemer]  fsssossnssomsn]  Jsnd
Visible fes
Filtar hd
t Sort Mone

Why were Sorts Removed from Measure Iltems?

Sorts will be removed from measure items in these cases:

e Case 1 - You sort one measure item then apply a sort to a different measure item.

e Case 2 - The sort on the measure item was associated with a particular level, and you remove that level
from the view.

e Case 3 - You sort a measure item then sort a level on the opposite axis.

See also Can Multiple Objects be Sorted in Views?
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Casel

In this view, there is a sort on the Sales Units measure item.

/= View Filter ¥ product Group

T Year Based ==
Year Based Months Based-Year Based-Abs Year

Months

1

ber

5
g
4

-

EEE‘
ol

E"“ELEIEEE

E"' View Name: Monthly sales Views fiftered by Product Group

Last Year

2013

Sales
Amount

§134,726370
$120 630,704

§75.665 211
$191,238 4834
5166,186.115
$170.458,747
§180,174.622
$152,231,793
§204,244.740
$281,383,297
$242 788 266
£1 39,5-145,211

Sales Units
2,325,511
2,057,686
1,281,288
3486263
3,055,288
3,141,045
3,358,940
2,821,829
3,787,346
5,152,400
4,446 061
3,484,795

Current Year

2014

Sales
Amount

$93,102,611
$87,153,548
599415393
$103,686,072
$110.814,559
$117,183,682
$120,192.437
$137.459,746

[ & Sales Uni

Units

1,695,884
1,782,815
1,828,038
2,232,003
2,541,088
2,888,562
3,022,329
3.672.251

1130,593 183

Applying a sort to the Sales Amount measure item removes the sort that had been on the other measure item.

3,963.6

4|2/ View Filter ¥ product Group|

T Year Based ==
Year Based Months Based-Year Based-Abs Year

Months

EIZ+ View Name: Monthly Sales Views fiftered by Product Group

Last Year
2013

Sales
Amount

§188 546211
§242 788 266
§281,383.287
£204,244 740
§152,231,793
$1R0,174.622
$170,458,747
$166.186.113
§191,238,484
£134,726 370
$120,630,704

§75.665211

Sales Units

3,484,793
4,446 061
5,152,400
3,787,345
2,821,829
3,359,940
3,141,043
3,055,288
3,486,263
2,325,511
2,057,686
1,281,288

Current Year

2014

Amount
$180,553 183
§137 459,746
$120,152 437
$117,183 692
§110,814,55%
$103 686,072

§95.415,393
$07,153,548
§93,102,611

Grand Totalls2,109278 560|38359 452[ 1 059 601 202 3.e27.701

[ ¥ Sales '\ shles Units

3,963,651
3,672,251
3022329
2,888,562
2,541,088
2232003
1,828,058
1,782,815
1,695,884
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Case 2
There is a sort on the Daily Sales Amount measure item for member C of the Product ABC Class level.

EXZ+ View Name: Daily Sales by Product ABC Class
4| View Filter
Product ABC
Class == A B c D
" " /'_\ " "
Daily Sales  Sales  Daily Sales  Sales ¥ Daly | sales Daity Sales  Sales
Product  PBrnd Amount ~ Unts  Amount  Units | Sales | Units  Amount  Units
- Ilong  \y 385014 Wk38 Wk382014 Wk3g | Amount | wk3g wWk382014 Wk38
frand Description "4 k38  2014to  toWk38 2014to |Wk382014| 2014ty towWk38  2014to
2014 Wk 38 2014 wk3g | toWk38 | wk3s 2014 Wk 38
2014 2014 2014 2014 2014
011 First Choice $7,131 1,640 59,397 1,713 55,808 1,308 517 4
009 Farm Fresh $10,432 1469 514281 2,671 $5,384 904 $8,193 1,563
010 Prime Grown $6.656 1224 $4.334 593
o002 Dew Drop $1.166 438 §2,955 429
007 SugarDrop §2,071 305
001 Tip Top §3,903 531
003 SuperSweet 51436 352
004 Idaho Delight $1,573 414
0as Farm Crisp 52,835 778
006 Southern Sweet 83,544 531 $3,034 834
008 Bing-a-ling £4.022 574
012 Home Cookin® $7,132 794 56,947 509
994 Private Label

The Product ABC Class level is removed from the view; therefore, the sort is removed.

EZZ + View Name: Daily Sales by Product ABC Class

4|~ View Filter
ol LR m i L DR ﬁfﬁ T ﬁﬁfﬁ'ﬁfﬁ 2014
011 First Choice §22,353 4 666
009 Farm Fresh £38.290 6,697
010 Prime Growr $10,550 1,317
o002 Dew Drop £4.121 867
o007 SugarDrop 52,071 305
001 Tip Top §3,903 531
003 Supersweet 51,436 352
004 Idaho Delight £1,573 414
005 Farm Crisp 52,833 778
006 Southern Sweet 56,579 1,363
008 Bing-a-iing §4,022 574
012 Home Cookin® §14.080 1,603
999 Private Label §4.535 1,124
Coandvorl] | eunss]  ouesy
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Case 3

In this view, measure items are on the rows axis. There is a sort on one of the measure items.

Budget
Amount

Grand Total - $5,078,516,759|  §2,219.250,196
Wo!

| | |salesamount| s4977.057.97| $2.88247.89

EiZ - View Name: Sales and Budget by Region, RepBroker
4|~ View Filter
RepBroker > > 300 305 313 312 302
Region Di?;‘ri)ﬁmg Dﬁclrriltimg Nicole Toscano Janice Tierney Eleanor Toman IMike Hartney Mark Fedler John
330 East B“dﬁ: r"‘j‘_"“;"t $5.078,516,75%  $2,219250,196  $1852719.651  §1.423069.721 $600,722,027 53
b Sﬂ? $4.977.057972  §2,188,247.896  $1,813251,060  §1,392,813,357 $588,990,820 )
Cumulative Sales $4.977.057.972 48 $7.165.305,868.54 $8.978,556,028 88 $10,371,370,786.37 $10,960,361 60650 $11.315)
Sales 9% Total 41.00% 18.03% 14.54% 11.47% 4.85%
Budget Amount
331 West Working $314.604.275 s:I
Sales Amount §312,314,732 g
Cumulative Sales $312,314,732.03 §457)
Sales 3% Total 13 .88%

£1,852,719,651

$915,326,307

$1,813,251,060]  $1,392,813,857 $901,305.552

Then a sort is applied to the level on columns, which removes the measure item sort.

iI= View Name: $Sales and Budget by Region, RepBroker
4|~ View Filter

318

¥
RepBroker == 31
Rgn long | RepBrLong

D inti = Meidl MacDonald Mary Lopez

313 312 309

Eleanor Toman Mike Hartney Terry Bruno

Budget Amount
Working

Sales Amount
Cumulative Sales
Sales % Total

Budget Amount
Working

Sales Amount 5175890506  $474,781,394
Cumulative Sales $173,899,506.29 $650,681 40034

East

West 5176582304  $479,040,355

$321,722.9%6

$1,813,251,060  $1,392,813,857 $316,327,928
$1,813,251,060.34 53 206,064,917.83 $3,522.392,846.22
14.94% 11.47% 2.61%

51,852,719.651  $1.423.069.721

§30¢

838
§1,040.3

Sales % Total T.81% 21.09%

Budget
Grand 'I'ntal Amount $176.582,394| $479.040,355| $1,852,719.651| 51,423,065, $321,722,996
Working

| | [salesamount| sizssm9s06] saramsiess] sisisasioco] siamsasst]  saieaos|

Sales % Total
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